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NEW FEATURES 

Structure 
Run Management 
Improved creation and editing of multiple analysis types with results in the Model Browser. 

 
For more information, see Manage Runs. 

  

https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/unity_basics/manage_runs_t.htm
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With the new Structural Load Cases, you can create and edit linear static and buckling loads. 

 

With the Modal Load Cases tool, you can create and edit modal and modal prestress loads. 
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For more information, see Load Cases. 

SimSolid Run Status 
When running a SimSolid analysis, run progress is displayed in the status bar at the bottom of the 
Inspire window. 

 

Entity Information 
Right-click any entity in the Model Browser and select Info to display additional information about 
that entity. 

 

  

https://2025.help.altair.com/2025.1/inspire/en_us/topics/inspire/structure/load_cases_inspire_c.htm
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Suppress/Unsuppress Entities 
Suppress or unsuppress an entity using the context menu in the Model Browser. 

Entities that are suppressed do not appear in the modeling window and are not included in 
calculations such as optimization, static weight calculations, mass computations, etc. 

Entities that are suppressed are displayed in grayed-out, italicized text in the Model Browser and 
removed from the modeling window until unsuppressed. 

  
For more information, see Suppress or Unsuppress. 

 

Contacts 
Preferences > Inspire > Run Options now allows you to set a default for Contact type for parts 
with fasteners. 

Self Contact support was added to the Contacts tool for SimSolid. 

For more information, see Contacts. 

 

Spot Welds 
The spot welds workflow was improved with multiple methods of creation. 

For more information, see Spot Welds. 
  

https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/unity_basics/mbrowser_suppress_unsuppress_st_t.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/inspire/structure/contacts_inspire_c.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/inspire/structure/spotwelds_inspire_c.htm
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Motion 
Multibody simulation can be applied at various design stages, from conceptual design and 
load/stress calculations to the operational assessment of the overall system. Until now, Inspire 
Motion has primarily focused on the intermediate stage, where users begin with an existing CAD 
model and assemble the mechanism based on geometric features to conduct load and stress 
analysis on critical components. 

   
Initial Stage 
Conceptual Design 

Intermediate Stage 
Load & Stress Calculations 

Final Stage 
Operational Assessment 

Start with a skeleton mechanism to 
test the general principle. 

Outline part shapes and consider 
interference issues. 

Coarsely define actuator 
characteristics (springs, drivers, 
etc.) and mass/inertia for each 
body. 

Optimize the design for 
performance. 

Design detailed CAD models and 
select materials. 

Assemble the mechanism based on 
geometric features. 

Perform load & stress analyses on 
critical components. 

Optimize parts for 
manufacturability. 

Conduct the most complex analysis 
to understand real behavior. 

Introduce structural compliance 
and detailed actuator 
characteristics. 

Optimize the overall system 
behavior. 

With this release, Inspire Motion has been enhanced to support the initial design stage, allowing 
you to start with a skeleton mechanism to define the general principles. At this stage, components 
often have primitive shapes, and joints are typically based on hard point locations and 
conceptualized designs. 

Furthermore, Inspire Motion has been upgraded with sophisticated entities, enabling the 
integration of controllers, nonlinear mathematical equations, and multi-physical capabilities by 
importing Functional Mock-up Units (FMUs). This allows for the simulation of complex systems to 
assess operational viability during the final stage. 

In this release, we introduce approximately 70 new modeling entities into Motion. To maintain a 
clean interface with easy-to-follow workflows, Inspire Motion now offers two distinct profiles: 
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Motion Designer Profile: Designers typically begin with CAD, leveraging existing geometrical 
features to define the connections within their mechanisms. The primary objective is to evaluate 
the performance and functionality of an existing design. This profile is similar to the previous 
version of Inspire Motion.  

Motion Analyst Profile: Analysts often start with a blank slate, employing a hard-point-based 
design approach. Hard points represent critical locations, such as mounting points or load-bearing 
connections within and between assemblies. Using these points, mechanisms are constructed with 
simplified primitive shapes. Joints, located at the hard points, are conceptual in nature. The focus 
here is on gaining a fundamental understanding of how a new mechanism might function before 
applying detailed shapes or refinement. 

This dual profile approach allows Inspire Motion to cater to both the refinement of existing designs 
and the conceptual development of new mechanisms, offering flexibility and precision for diverse 
needs. You can navigate between the profiles. 

 

Motion Analyst  
With Motion Analyst being a completely new profile with numerous features, including all details in 
these release notes is not practical. Please refer to the help for a comprehensive overview of the 
new features. For more information, see Motion Analyst. 

 

Ribbon Switching (Motion Designer to Motion Analyst) 
An icon is available for toggling the main ribbon view between motion profiles.  

 

  

https://2025.help.altair.com/2025.1/inspire/en_us/topics/inspire/motion/motion_analyst_c.htm


 

 Altair Inspire 
Release Notes   I P a g e  8 

 

Bushing Moved to Motion Analyst 
The Bushing feature has been improved and moved to Motion Analyst and is represented by a new 
icon. Separate from structural bushings, motion bushings now provide additional support for 
modeling linear and nonlinear behavior as well as symmetrical pairs.  

 
For more information, see Bushings. 

 

Eigenanalysis Moved to Motion Analyst 
The Eigenanalysis feature has been moved to Motion Analyst, and like previous versions, can be 
accessed from the Motion Run Settings.  

 
For more information, see Eigenanalysis. 

  

https://2025.help.altair.com/2025.1/inspire/en_us/topics/inspire/motion/bushings_analyst_c.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/inspire/motion/linear_analysis_c.htm
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Flex Bodies Moved to Motion Analyst 
Flex body analysis, including Create Flexible Body, have been moved to Motion Analyst under a Flex 
Body tool group.  

Two additional methods for modeling with flex bodies have been introduced: Replace and Import. 
With Replace, you can replace any rigid part with a flexible part, using a flex body H3D file. During 
the replace operation, all joints and motion entities attached to the flex body are preserved. With 
Import, a flex body H3D can be imported into the model and Motion Analyst hard points are 
automatically defined at each interface node, ready for connecting joints and other entities to the 
part. 

Finally, there is a new View Modes tool that opens the flex body modes review context. Previously, 
this was accessed by selecting the Create Flexible Body tool. 

 
For more information, see Flexible Bodies. 

  

https://2025.help.altair.com/2025.1/inspire/en_us/topics/inspire/motion/flexible_bodies_c.htm
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Improved Analyze Part (Motion Designer) 
The Analyze Part feature has been improved to provide faster and more accurate results. Previous 
methods employed inertia relief FE solutions on a rigid part, using selected load steps from the 
motion analysis. New methods employ creating an implicit flex body, solving a complete flex body 
motion analysis and placing you directly into the results review context. Although it is 
recommended to first verify that the motion analysis is running as expected, there is no longer a 
need to run the motion analysis as a prerequisite to performing Analyze Part. 

 

 
For more information, see Analyze Part. 

 

Revised Icons (Motion Designer) 
Some icons have been updated with a new look: 

 
  

https://2025.help.altair.com/2025.1/inspire/en_us/topics/inspire/motion/analyze_part_motion_c-1.htm
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Review Group (Motion Designer, Motion Analyst) 
The Review group icons have been rearranged into a dropdown to conserve space on the ribbon. 
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Fluids 
Inlet Material Specification 

 
You can now specify the material that flows through an inlet using the Add material option in the 
inlet microdialog. This is useful when a model has multiple inlets with different nonmixing fluids 
flowing through them. This feature must not be used for simulating mixing fluids with different 
materials. One supported application is the Lattice Heat Exchanger, which typically has two 
different materials entering at two different temperatures. The two fluids are separated by a solid 
lattice, which prevents the fluids from mixing. 

Example Lattice Heat Exchanger with 2 inlets and 2 outlets 

 
Hydraulic oil entering the first inlet at 350 Kelvin 
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Water entering the second inlet at 298.15 Kelvin 

  
For more information, see Inlets. 

 

Fan Option in Inlet and Outlet Boundary Conditions 

 
The Inlet and Outlet tools now include a Fan option to model the effects of a fan on the fluid via the 
specification of the fan P-Q curve. 

 
For more information, see Inlets and Outlets. 

  

https://2025.help.altair.com/2025.1/inspire/en_us/topics/cfd/inlet_t.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/cfd/inlet_t.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/cfd/outlet_t.htm
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Particle Visualization 

 
In the Analysis Explorer, you can now opt to view fluids analysis data as moving particles. The 
particles can be visualized as either spheres or arrows. 

For more information, see Style Options. 

 

Real Time Results Visualization 
Results data will appear as they are available rather than after the entire simulation finishes. This 
feature is supported only when the simulation is performed on NVIDIA GPUs. Currently, volumetric 
render visualization and section-cuts are supported in real-time mode. Before launching the 
simulation, select the Use Realtime Visualization option in the Run Fluid Analysis dialog to use this 
feature. 

     
For more information see Run Status. 

https://2025.help.altair.com/2025.1/inspire/en_us/topics/cfd/show_cfd_analysis_results_t.htm#reference_zzr_bqg_hsb
https://2025.help.altair.com/2025.1/inspire/en_us/topics/cfd/run_cfd_analysis_t.htm#id_gjf_vgh_l2c
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New Result Types 
The following new result types—Turbulent Viscosity, Heat Flux, and Heat Transfer Coefficient—are 
now available in the Analysis Explorer. 

     
 

 
For more information see Result Types. 

 

AMD Graphics Cards Support 
Fluids simulations can now be performed on AMD graphics cards belonging to the architectures 
RDNA2, RDNA3, and RDNA3.5. 

 

https://2025.help.altair.com/2025.1/inspire/en_us/topics/cfd/show_cfd_analysis_results_t.htm#reference_mtg_2jg_b2b__section_oqt_1kg_b2b
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Implicit Modeling 
Ribbon Reorganization 
The tools on the Implicit Modeling ribbon have been moved into 3 separate groups (Create, Lattice, 
Modify) to better categorize the tools into fundamental types. The main change is the addition of 
the Lattice group, moving Convert to the Create group. 

 
 

Strut Latticing Overhaul 
Point-Edge Set and Point-Edge Set Filter are now available through the Implicit Modeling ribbon 
along with a new Point-Edge Set Operator tool. 

 
For more information, see Point-Edge Set. 

Point-Edge Sets can be converted into strut lattices using the Point-Edge Set to Struts tool 
(previously Stochastic Lattice), and four new modes of strut lattice buttons have been added to 
the ribbon to streamline common workflows: Regular Struts, Struts From Part, Pin/Perforate, 
and Import Struts. 

https://2025.help.altair.com/2025.1/inspire/en_us/topics/implicit/point_edge_set_c_dita.htm
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These four buttons will guide you through the process of generating a point-edge set with the 
correct options and thicken them into struts similar to the workflow of stochastic lattices in 2025. 

For more information, see Streamlined Workflows Using Point-Edge Sets. 

 

Point-Edge Set Updates 
There have been several capability and usability improvements for the Point-Edge Set tool. 

Uniform Random and Minimum Spacing point generation modes now provide four options for 
generating points: Inside, Outside, Surface, and Bounds. 

https://2025.help.altair.com/2025.1/inspire/en_us/topics/implicit/point_edge_sets_c.htm#reference_y33_clx_v2c
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The From Part/Mesh generation method now provides four options to extract points and edges 
from selected objects: Surface Mesh, Volume Mesh, Part Curves, and Sample UV. 

 
To make it clearer for the user, the buttons will become enabled if that type of data is available on 
the selected object. 

The Normal At Point option for creating edges at each generated point now provides the option to 
provide a custom Normal Field as opposed to the target object that was created to generate the 
points. In the example below, the right image shows what happens when you apply the field of the 
Z Plane to the Normal Field parameter as opposed to the default surface normals of the sphere. 
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It is now possible to generate only points in a point-edge set by selecting the Points Only option in 
the Edge Generation Method. This will skip the edge generation and produce only points. 

 
A new Export button was added to the Point-Edge Set panel to allow users to save a list of the point 
coordinates or a list of the edge connectivity to a CSV file in the same format that is used to import 
point-edge sets and point clouds. 

For more information, see Point-Edge Set. 

 

  

https://2025.help.altair.com/2025.1/inspire/en_us/topics/implicit/point_edge_set_c_dita.htm
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New Point-Edge Set Filters 
Four new point-edge filters were added in this release to help fine-tune point-edge sets. Point 
Merge and Edge Collapse both help reduce the density of points/edges in the set. A new Point 
Angle filter keeps/removes points based the angle of a target field and a reference field at each 
point. Points can now be shifted either by a specific or random amount by using the Perturb point 
filter. In 2025 the Trimming filter was added, but in 2025.1 it is now possible to close the lattice ends 
that were trimmed by the filter, either connected to nearest points directly or across the surface. 

 
For more information, see Point-Edge Set Filter. 

 

Point-Edge Set Operator 
A new Point-Edge Set Operator tool has been added to allow operations between two or more 
point-edge sets. In the 2025.1 release there are two operators to use: Union and Bridge. 

Union will simply combine multiple point-edge sets into a single point-edge set similar to a Boolean 
combine. However, any duplicate points or edges will be removed, and only unique points and 
edges will be preserved. 

The bridge operator will connect points from the target set to the nearest N points in the tool set, 
which is specified with the Valence parameter. 

https://2025.help.altair.com/2025.1/inspire/en_us/topics/implicit/point_edge_set_filter_t.htm
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For more information, see Point-Edge Set Operator. 

 

Strut Fillets and Nodes 
The Point-Edge Set To Strut tool now provides the option to create spheres at each node in the 
point-edge set, as well as add fillets or chamfers at the intersection of struts. 

 
For more information, see Streamlined Workflows Using Point-Edge Sets. 

 

  

https://2025.help.altair.com/2025.1/inspire/en_us/topics/implicit/point_edge_set_operator_t.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/implicit/point_edge_sets_c.htm#reference_y33_clx_v2c
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FEM Export of Struts 
Strut lattices can be directly exported to an FEM file from the Point-Edge Set to Struts tool using the 
new Export button. 

 
This file format can be used in various Altair solvers and removes the need for exporting the lattice 
geometry as a mesh. The struts are exported as CBAR elements with PBAR properties for the 
thicknesses of the struts. 1D elements can also be imported into Inspire through an FEM file and 
converted to a point-edge set through the From Part/Mesh mode. 

For more information, see Streamlined Workflows Using Point-Edge Sets. 

 

Plane Cut 
A new Plane Cut tool has been added to the Implicit Modeling ribbon to allow cutting an implicit 
body with a manually defined or dynamically linked plane. There are four modes to the plane cut 
tool: Regular, Inverted, Plane, and Contour. These modes can be seen below: 

https://2025.help.altair.com/2025.1/inspire/en_us/topics/implicit/point_edge_sets_c.htm#reference_y33_clx_v2c
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For more information, see Plane Cut Implicit Geometry. 

 

Isosurface 
An Isosurface tool has been added to the Implicit Modeling ribbon to allow extracting surfaces 
from any type of implicit body or field. This is especially useful to create a surface from analysis 
results and create optimized topologies for results from solvers other than structural analysis. For 
example, the tool can be used to create a more optimal fluid volume based on Inspire Fluids 
results. 

 
For more information, see Isosurface Implicit Fields. 

https://2025.help.altair.com/2025.1/inspire/en_us/topics/implicit/plane_cut_implicit_geometry_t.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/implicit/isosurface_implicit_fields_t.htm
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Fields from More Analysis Results 
In 2025, Inspire added the ability to create implicit fields directly from the Analysis Explorer for 
OptiStruct and Fluids results. This has been expanded to all results types that are attached to a 
solid body, including imported analysis data through H3D files. For example, on the left, a field was 
created from SimSolid analysis results; on the right a field was created from Inspire Cast results 
through an imported H3D file (the shell thickness is based on the distance to the ingate in the 
casting analysis). 

 
For more information, see Create Implicit Fields from Analysis Results. 

 

  

https://2025.help.altair.com/2025.1/inspire/en_us/topics/implicit/implicit_fields_from_analysis_t.htm
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Curve-To-Curve Conformal Pattern 
A new option has been added to the surface tab of the conform panel which allows you to pick two 
curves and create a lofted UV space between the two curves. 

 
For more information, see Conformal Coordinate Spaces. 

 

Pattern Smoothing & Scaling 
Fillets or chamfers can now be added between copies in an Implicit pattern, as well as a scaling 
factor for patterned objects. Both parameters can be field driven. 

 
For more information, see Pattern Implicit Geometry. 

 

https://2025.help.altair.com/2025.1/inspire/en_us/topics/implicit/conformal_spaces_c.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/implicit/pattern_implicit_t.htm
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Thickness Parameter for Double Surface Lattices 
You can now choose between specifying a density or an actual thickness value. The thickness value 
can be constant, variable, or field driven. This is a very important parameter to control exact sizing 
for components such as heat exchangers. NOTE: Due to the nonlinear nature of surface lattice 
equations, the thickness is technically an approximate value. The thickness should be very accurate 
near the non-thickened surface and may lose tolerance farther away from the non-thickened 
surface. 

 
For more information, see Create an Implicit Surface Lattice. 

 

Dynamic Link to Sketches 
Sketches can be converted directly in the Implicit Convert tool, and all curves contained within the 
sketch will be converted to implicit curves. These can be used in various workflows, either in a 
point-edge set using the From Part/Mesh mode, used directly in a unit cell for Planar or Cell-Strut 
lattices (it will be listed in the Unit Cell dropdown), in a field, or directly in any Modify tool such as 
Offset. Any edits made to the sketch will be updated in the implicit part, just like any other dynamic 
link from converted parts. 

https://2025.help.altair.com/2025.1/inspire/en_us/topics/implicit/surface_t.htm
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For more information, see Convert to Implicit Geometry. 

 

Cross-Implicit Part Referencing 
You can now select implicit parts later in the construction history to reference implicit bodies from 
earlier implicit parts. A dynamic link will be maintained across the two parts, so if the previous 
implicit body is edited, this will be reflected in the later part. It is recommended to hide the body in 
the first part as it will look duplicated in the second part. 

For more information, see Construction History. 

 

Enhanced 3MF Extension Support 
The support for the 3MF beam extension has been enhanced to also support per-node radii both 
for import and export. Imported 3MF files with beam extension data will now be directly loaded in 
as an implicit point-edge set and thickened to the appropriate radii contained in the 3MF data. 

3MF files from Inspire can now include volumetric data as well as mesh and beam data. The 
volumetric data resolution will match the visualization quality of the implicit parts in the model. For 
now, importing 3MF volumetric data is not supported. 

For more information, see Supported File Formats.  

https://2025.help.altair.com/2025.1/inspire/en_us/topics/implicit/convert_t.htm
https://2025.help.altair.com/2025.1/form/en_us/topics/shared/parametric/history/construction_history_c.htm
https://2025.help.altair.com/2025.1/form/en_us/topics/shared/unity_basics/file_formats_st_r.htm
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Performance Improvements 
The implicit engine architecture was significantly overhauled to avoid unnecessary recomputing of 
geometry (implicit construction history). You should expect a general widespread speedup of 
implicit modeling workflows. 

 

Geometry 
Drape 
The Deform tool now includes a Drape tab that you can use to drape one or more parts over a 
surface. 

 
For more information, see Deform. 

 

Custom Deform Axis 
The Deform tool now includes a Custom setting in each tab, allowing you to deform parts with 
respect to a linear edge or axis selected using the Axis collector. 

 
For more information, see Deform. 

  

https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/geometry/deform_c.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/geometry/deform_c.htm
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Pattern Along Surface 
The new Pattern Along Surface tool allows you to select parts and create copies over a surface. 

 
For more information, see Pattern. 

Target Part for Combine Operations 
In the Extrude, Revolve, Sweep, Multi Sweep, and Loft tools, you can use the Target checkbox and 
collector to select the target part when performing a Combine operation. 

 
For more information, see Extrude. Revolve, Sweep, Multi Sweep, or Loft. 

https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/geometry/pattern_c.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/geometry/extrude_sketch_c.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/geometry/revolve_faces_st_t.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/geometry/sweep_t.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/geometry/multi_sweep_t.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/geometry/loft_t.htm
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Updated Extrude Tool 
You can now use the Extrude tool to extrude from a surface or plane, or to extrude a profile with an 
offset: 

 

 
For more information, see Extrude. 

 

Sketching 
Spline Tangent and Magnitude Handles 
When using the Spline Through Points tool, handles are displayed to allow you to change the 
tangency and magnitude of the spline curve. 

Drag the diamond control to adjust the tangent curve: 

 
Drag from the arrowhead at either end of the tangent line to change the magnitude: 

https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/geometry/extrude_sketch_c.htm
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Drag the point at either end of the tangent line to change tangency and magnitude simultaneously: 

 
For more information, see Splines. 

 

Show Image Plane Outside of Sketch 
The Image Plane feature now includes a Show Image Plane Outside of Sketch option. 

If you want the image to remain visible outside of the Sketch context, right-click the modeling 
window and select Show Image Plane Outside of Sketch (or Preferences > Sketching > Show 
Image Plane Outside of Sketch). When the option is not selected, the image plane is not visible 
when you leave the Sketch context.  

For more information, see Image Plane. 

 

Sketch Midpoint Line 
The Line tool now includes a dropdown to choose the type of line to create. 

Choose Midpoint Line to create a line using the midpoint and either endpoint.  

 
Choose Single Line to create a line by defining the end points. 

For more information, see Points/Lines. 

 

https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/parametric/sketching/splines_c.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/parametric/sketching/sketch_image_plane_c.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/parametric/sketching/point_line_c.htm
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Convert to Construction and Convert to Infinite Lines 
The Sketch Constraints toolbar now includes options to convert a sketch curve to construction 
geometry and convert a line to an infinite line.  

 
For more information, see Sketch Constraints. 

 

Hide Sketch Plane After Sketch Creation 
Use Preferences > Sketching > Hide Sketch Plane After Sketch Creation to control whether the 
reference plane is hidden or visible after exiting the Sketch context. 

For more information, see Preferences: Sketching. 

 

Picking Priority 
Picking priority is now given to underdefined sketch entities if they overlap fully defined entities. 

  

https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/parametric/sketching/sketch_constraints_c.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/preferences/preferences_sketching_r.htm
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PolyNURBS 
Move Bodies 
When you use the Move Bodies tool, the last-used alignment is now saved. In previous releases, the 
axis was aligned to the global axis. 

To switch between the global axis and PolyNURBS alignment, click the center of the graphic 
manipulator: 

 
For more information, see Move Bodies. 
 

Pave 
The Pave tool includes the following improvements: 

• Reference points are now supported when using the Pave tool. 

• You can Ctrl-click in space with the Pave tool to use the nearest global plane. 

 

  
Ctrl-click a reference axis or plane to select it. While the reference is selected, all points you click will 
snap to the axis or plane. Ctrl-click the reference again to deselect it.   

For more information, see Pave. 

https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/geometry/move_bodies_c.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/geometry/polynurbs_pave_c.htm
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Rendering 
Blend 
The new Blend option of the Texture Positioning tool allows you to control intersecting textures to 
either blended or sharp transitions. 

 

Ambient Occlusion 
Performance Render mode now has options to control lighting and shadow effects. Intensity and 
Radius parameters allow you to increase or decrease the ambient occlusion effects. 

 

Performance Render options in the Settings tab of the Render Editor 
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Ambient Occlusion – None  

 
 

Ambient Occlusion – Approximate 100% 

 
 

For more information, see Define the Rendering Settings. 

 

https://2025.help.altair.com/2025.1/inspire/en_us/topics/studio/rendering/edit_render_settings_t.htm


 

 Altair Inspire 
Release Notes   I P a g e  36 

 

General 
Camera Animation 
You can now animate the camera to view your model and record the animation in any display 
mode. For models without animated results, in the view controls in the lower left of the modeling 
window, click the Create Camera Animations tool to activate the timeline. (For models that 
already include animated results, the timeline appears automatically.) 

 
Then, click the icon at the far right of the timeline to access Turntable, Path, and Object animation 
options. 

 
• Turntable lets you set rotation direction, number of rotations, duration, and enable Helix 

for vertical movement. 

• Path allows you to define multiple camera positions and set the duration between them. 

• Object lets you choose a part for the camera to stay aligned with. 

For more information, see Create Camera Animations. 

  

https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/unity_basics/camera_animate_t.htm
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Updated Systems Tool 
The Systems tool has been moved to the Home tools.  

You now use it to create and apply user-defined coordinate systems to loads, supports, and 
displacements. This is useful for aligning loads to a local coordinate system rather than the global 
coordinate system. Keep in mind that results are only shown in the global coordinate system. 

 

 
For more information, see Systems. 

 

List View in Model Browser 
Select List View to view the Model Browser as a sortable list view with groups of assemblies and 
parts. You can click a column heading to sort each group in increasing or decreasing order. 

 
When List View is not selected, the Model Browser is displayed in a hierarchical tree view. 

For more information, see Change the Model Browser View. 

 
  

https://2025.help.altair.com/2025.1/inspire/en_us/topics/inspire/structure/systems_c.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/unity_basics/mbrowser_view_options_st_t.htm
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Double-Click to Edit Entities 
Double-click an entity in the Model Browser to edit it. 

 
For more information, see Edit. 

 

Align Section Cut 
To align the model so the section cut is aligned with the current view, right-click the section plane in 
the Model Browser and select Align Normal to View. 

 
For more information, see Create a Section Cut. 

 

Collapse/Expand Ribbon 
To switch between having the ribbon collapsed or expanded, do one of the following: 

• Go to View > Ribbons > Collapse Ribbon. 

• Double-click a ribbon tab to collapse or expand the ribbon. 

 
For more information, see Workspace. 

 

Guide Panel Redesign 
Guide panels for all geometry tools have been redesigned. 

https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/unity_basics/mbrowser_edit_t.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/unity_basics/view_section_cuts_st_t.htm
https://2025.help.altair.com/2025.1/inspire/en_us/topics/shared/unity_basics/workspace_inspire_r.htm


 

 Altair Inspire 
Release Notes   I P a g e  39 

 

 

Python API 
Geometry 

• Added support for Pattern Along Surface to create copies of parts over a surface. 

• Added support for Drape capabilities to drape one or more parts over a surface. 

• Added Target Part for Combine Operations capabilities to Extrude, Revolve, Sweep, 

Multi Sweep, and Loft tools, allowing you to set the target during combine 

operations. 

• Added support for creating parametric coordinate systems. Use the API to create and 

apply user-defined coordinate systems to loads, supports, and displacements. 

 

Implicit Modeling 

• Added support for creating point-edge sets, point-edge set filters, and point-edge set 

operators. 

• Added support for Plane Cut to cut implicit bodies with four different modes such as 

Regular, Inverted, Plane, and Contour. 

• Added Isosurface capabilities to extract surfaces from any type of implicit body or 

field.  

• Enhanced Pattern with Fillet, Chamfer, and Scale options to add fillets or chamfers 

and scale to the copies of implicit patterned objects. 

• Enhanced Surface Lattice with a Thickness option to control the exact size of the 

components.  
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Structure 

• Added support for creating and modifying Structural Linear Static, Buckling, Modal, 

and Modal Prestress load cases to control the buckling, modal, and modal prestress 

at the load-case level. 

• Added support for creating and modifying solution settings to control the SimSolid 

solution settings such as Solution Adaption, Groups, Adapt to Feature, Adapt to Thin 

Solids, and Refinement at the load-case level.  

• Added support for creating and modifying pretension groups to add pretension 

groups and control the pretension force per individual fasteners. 
 

Enhancements 

• Enhanced the getReactionForces to return reaction forces and reaction moment’s 

components along with position. [INSPIRE-46966] 

• Supported parametric variable on Solid Ellipsoid primitive. 

• Added support for Sketch Midpoint Line; the Line tool now includes a dropdown list 

to choose the type of line to create. 

• Enhanced Seam Weld capabilities 

• Enhanced geometry Tag capabilities 

• Enhanced the Extrude capabilities; you can extrude from a surface or plane or 

extrude a profile with an offset. 
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DEPRECATED FEATURES 
The following features and options have been deprecated in Inspire 2025.1: 

• The Solver Expression input option found in the Profile Editor has been removed 

from Motion Designer. In exchange, Motion Analyst supports a wider array of 

options for writing custom input expressions for motions and forces. Existing 

expressions are supported. 

Collaboration Tools 

• The Collaborations tools have been deprecated in this release. 
 

RESOLVED ISSUES 
• Fixed an issue that caused some older models to crash when loaded into a newer 

version of Inspire. [INSPIRE-47615] 

• Fixed an issue that prevented setting the default Inspire product version to launch 

and load an STMOD file from Windows Explorer. [INSPIRE-47465] 

• Fixed an issue where the IPS units were not respected in the material properties and 

reaction forces when generating a report in Inspire. [INSPIRE-47463] 
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KNOWN ISSUES 
• When exporting a load case to a CSV file, the following parameters are not exported. 

[INSPIRE-47918] 

o Load case types (Modal) 

o Linked Load cases (Modal Prestress, Buckling) 

o Number of Modes 

o Grounded Fasteners 

o Pretension 

o Inertia Relief 

o Connectors. 

• When using an AMD GPU, recent diver updates can cause issues with rendering and 

implicit visualization. Rolling back to a previous AMD driver version can resolve the 

issue. 

• When running a Fluids analysis and viewing Heat Transfer Coefficient and Heat 

Flux result types in the Analysis Explorer, vectors are displayed in grayscale and can 

cause the application to crash.  

• When running a Fluids analysis, Heat Transfer Coefficient and Heat Flux result 

types are not hidden as expected when the Static Streamlines and Vectors options 

in the Analysis Explorer are selected. 

• When running a Fluids Analysis on Linux, the fluid velocity does not update when the 

Use real time visualization checkbox is selected on the Simulation tab of the Run 

Fluids Analysis dialog. 

• When running a Fluids Analysis on Linux, contours do not update when the Use real 

time visualization checkbox is selected on the Simulation tab of the Run Fluids 
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Analysis dialog. Legends do update as expected. 

• When running a Fluids Analysis on Linux, Design Explorer simulations will fail if the 

Use real time visualization checkbox is selected on the Simulation tab of the Run 

Fluids Analysis dialog. 

• When running a Fluids Analysis on Linux, contours do not update and the simulation 

can crash when the Use real time visualization checkbox is selected on the 

Simulation tab of the Run Fluids Analysis dialog and the model includes rotating 

components. 

• When exporting H3D files on Linux, the application produces an error attempting to 

start hvtrans.exe. 

• As of October 14, 2025, Microsoft Windows 10 will reach its end of support. Following 

Microsoft's messaging, all Altair 2026 applications will no longer support Windows 

10. Altair is providing this information to help our customers prepare and 

accommodate for this change. Altair 2026 will support the Windows 11 operating 

system, along with our other Linux-based operating systems. Please contact your 

local Altair support teams if you have any questions or concerns. 
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